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Chapter 1: Storage Center Overview  
___________________________________________________ 

 

Introduction  

 

AfterOffice Storage Center is first and foremost a reliable offsite backup and restore application. With the 

built-in security and redundancy measures, Storage Center protects and safeguards your critical business 

data in case of natural disasters, break-in, and system or hardware failure, by automatically backing it up 

and storing it in a world-class secure datacenter.  

With the Web Storage, you can access the backed-up data via a web browser anytime anywhere. Also, the 

User Control Access Right (UCAR) allows the group access for specific folders when sharing 

collaboration work.  

Sending huge files via email will no longer be a problem with Storage Center in place. Other convenient 

features such as Public Links for upload and download also come in handy.  

Storage Center consists of mainly the Web Storage and StorageSync, which will be explained in details 

later.  
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Features  

 Automatic backup of your critical business data off-site  

 

 Central file and backup storage  

 

 Antivirus scan on all files being backed up  

 

 Built-in encryption for additional files protection  

 

 No hardware and software to purchase hence no system administrator necessary  

 

 Keep a daily, weekly and monthly version if you wish  

 

 Resume ability allows you to resume the backup after an Internet disconnection  

 

 Incremental backup allows the transfer of only the modified portion of the files  

 

 Restore files and folders to their original paths  

 

 Synchronize your files and folders in all your computers  

 

 Synchronization among multiple branches  

 

 With Web Storage, you can access your files and folders anytime anywhere  

 

 You can still access the files via Web Storage during a restoration  

 

 Share files and folders with your colleagues or business associates  

 

 UCAR allows folder access and actions of specific groups  

 

 DropFile makes sending huge files so easy and problem free  

 

 Receive files from the public  

 

 Public link available for external users to download files or web pages  

 

 Your business partners or customer can upload file via a Public Link  
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Three Ways to Access Storage Center  

 

1. Web Storage  

Access the Storage Center via a web browser. It can be any browser of your choice.  

 

2. StorageSync  

StorageSync is the software you install and run on your desktop or server to backup your data off-site.  

 

3. WebDAV  

WebDAV allows you to create a web folder in your Windows Explorer. The web folder displays 

exactly the same files and folders as you find in Web Storage. 
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Three Methods to Share Files and Folders  

 

1. Company Share Folder  

This is the common folder where all the Storage Center users can access and share files and 

folders. However, the Administrator (avomaster) is able to setup the access permission to allow 

certain groups of user to open or view certain folders, enabling a more secure and control 

environment for collaboration.  

2.  DropFile and DropFolder  

This is feature can be applied to both Storage Center and external users. Instead of emailing with 

file attachment, the email contains only links that allow the recipient to download the files 

intended to share.  

Storage Center users have the added advantage of receiving the files in their Dropbox and moving 

them to their desired folders.  

3.  Network Share or Private Share Folder  

When group sharing is not an option, you can choose to use Network Share to privately share the 

folder with other individuals on Storage Center. 

For more details, please refer to Chapter 4 and Chapter 6. 
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Chapter 2: Web Storage  
___________________________________________________ 

 

2.1 Web Storage Login  

Web Storage is essentially the user interface that you will see once login via the web browser. To login, 

you are required to have 3 pieces of information, namely Host, Username, and Password as shown in 

figure below.  

 

Figure 1. Login Page  

 

2.1.1 Domain Name for Your Storage Center  

You can use your own domain name, just like the example in Figure 1, where afteroffice.com is the 

domain name, if your domain name is hosted with AfterOffice. Alternately AfterOffice can also provide 

you with a sub domain, free of charge.  

 

2.1.1.1 Login with Your Own Domain  

Below is how it should look like with domain hosted with AfterOffice.  

 

Figure 2. Logging In with Your Own Domain 
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2.1.1.2 Login with AfterOffice Sub Domain  

If you have a domain but not hosted with AfterOffice or choose not to host with AfterOffice, that is 

perfectly fine as AfterOffice will provide you with a Sub Domain of your choice. Currently, AfterOffice 

is offering Sub Domain on vo.com.my, meaning if your company name is ABC Enterprise Sdn. Bhd., you 

can choose to have abc.vo.com.my as your sub domain if it has not been taken. When you login, it will be 

as follows.  

 

Figure 3. Logging in with AfterOffice Domain  

 

2.1.2 Landing Page for Storage Center  

 

Figure 4. The Landing Page Once You Login 

Figure 4 shows a full-fledge Storage Center at work with all possible modules plugged in. [Storage] and 

[Profile] are the menu items you will be using. 
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 Clicking on [Storage] leads to the Web Storage as below. 

 

Figure 5. Web Storage  

 

2.1.3 Change Your Password  

Click on [Profile] at the menu, then [Password] to change your password. 

 

Figure 6. Profile 

 

 

1 

2 
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Figure 7. Change Password  

Enter your current password at the [Current Password] field, then enter the new password at the [New 

Password] field and enter the new password again at the [Verify New Password] field. Click the [Update] 

button and you can close the window (click the cross at the upper right). 

 

2.1.4 Help       on Web Storage  

 

Figure 8. Help Available on Web Storage  

 

The red circles above are where you can get help on Web. The       icon will also appear on each section‟s 

upper-right corner of the action selected. For example, on [Delete] action, the       icon is shown as circled 

in the below figure. 
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Figure 9. The [Help] available on [Delete] action 

 

 

2.2 Default Folders in Storage Center  

 [Public Share] folder is reserved for AfterOffice to keep software 

and user guides for user download.  

[Company Share] is where you may share files and folders among 

co-workers within the company. Only the Administrator (avomaster) 

can create and remove sub-folders within "Company Share". If 

additional folder is required please contact the Administrator of your 

Storage Center.  

[Company Homepage] folder is only accessible to the Administrator 

(admin) of your company (domain). The Administrator can build a 

company related homepage here. Link to this homepage is:  

http://vo.[yourdomain].com/storage/homepage/[yourdomain].com/ind

ex.html  

or 

http://vo.[yourdomain].vo.com.my/storage/homepage/[yourdomain].v

v.com.my/index.html.  

Alternately, a public link for a file or image can be generated by 

replacing “index.html” with the file name.  

 

Figure 10. Default Folders 
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[Private] is the folder where you manage all your private files and folders. This is where you should back 

up your personal data files to.  

[Private Homepage] folder is where the user can upload his/her private homepage. Although the whole 

world can see your homepage, only you can manage and alter its content. Link to this home page is  

http://vo.[yourdomain].com/storage/homepage/[yourdomain].com/~username/index.html  

or  

http://vo.[yourdomain].vo.com.my/storage/homepage/[yourdomain].vo.com.my/~username/index.html.  

Alternately, a public link for a file or image can be generated by replacing “index.html” with the file name.  

[Network Share] folder stores all folders being shared to you by others from their Private folder. You can 

collaborate and share files with these individuals privately here.  

[Shared Items] is where you can view the folders you already shared to others, as well as folders being 

shared with you by others. Unsuccessful sharing can occur as a result of incorrect shared-to email address. 

Such entry will have the targeted email address displayed in a strike-through manner. The trashcan icon 

next to each entry can be used to remove a shared item.  

[DropBox] contain files dropped to you by others. When there is a "new" drop item, the animated tray-

being-filled icon is shown next to the DropBox(„N‟) link. „N‟ is the number of files in the DropBox. Once 

the DropBox has been listed, the icon is changed to a non-animated empty tray. 

 

 

 

 

 

 

 

 

 

 

 

 

http://vo.[yourdomain].com/storage/homepage/%5byourdomain%5d.com/~username/index.html
http://vo.[yourdomain].vo.com.my/storage/homepage/%5byourdomain%5d.vo.com.my/~username/index.html
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2.3 Web Storage Common Applications  

When you navigate into any of the default folders, you can see the main action buttons on the top most 

position of the files and folders. The figure below shows the main action buttons. 

 

Figure 11. The main action buttons. 

 

Other actions can also be performed on the files and folders. You can either click or right-click on a 

specific file/folder, then a vertical list of actions will be displayed, as shown in Figure 12. 

  

Figure 12. The action list is displayed in vertical when you click or right-click a file. 

If you have more than 1 file to take action to, you can check the check box of the file(s)/folder(s), and a 

horizontal list of actions will be shown as Figure 13.  

 

 

Figure 13. The action column is shown when you check the check box of the file(s) 
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2.3.1 Create New Folders  

Click on the [New Folder] button when you have come to the desired folder under which you like to 

create a new folder.  

Enter the [New Folder] name and its [Description]. The description will help you find the folder easier if 

it is accurate.  

Press on the [Create] button once filling up the fields, then your new folder will be created like the 

following example.  

  

Figure 14. Create a New Folder  

 

 

 

 

 

 

 



 
 

13 
 

 User Guide: AfterOffice Storage Center 

Copyright © AfterOffice.com Sdn. Bhd. All Rights Reserved. 

 

2.3.2 Upload Files  

Navigate to your desired folder then click on the [Upload] button. 

 

Figure 15. Upload Window  

Click on [Browse] to select the file to be uploaded. By default, the file selected for upload will replace 

any file with the same filename. If you do not wish to replace any existing files, uncheck [Replace 

existing file].  

By default, the upload window only shows up to 5 upload fields. If you have more files to be uploaded, 

click on the [Add] button.  

Press on the [Upload] button to upload the browsed files. 

 

2.3.3 Delete Files or Folders  

To delete a file, select the [Delete] action. 

Once you select the delete action, a Delete Window will display. Press [Okay] to confirm the delete of the 

selected files. Figure 16 below shows an example of the Delete Window. Folders can be deleted in the 

same way.  
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Figure 16. Delete Window  

 

2.3.4 Move Files or Folders  

To move any file or folder, use the [Move] action. You will see a similar window screen shot as below 

after selecting this action.  

 

Figure 17. After selecting the file and clicking on the [Move] action. 

Next, navigate to the desired folder where you want to place the file. You can either click on the [Browse] 

button, or select the destination folder from the side panel. In Figure 17 example, the PDF file is being 

moved to the /Company Share/Manual folder. Figure 18 below shows the navigation to the /Company 

Share/Manual folder. 
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Figure 18. Navigate to the folder “Manual” under “Company Share”.  

 

Click into the desired folder (i.e. the Manual folder). Then click on the [Paste] button and you will be 

prompted to confirm the move action as in Figure 19. 

 

Figure 19. Click [OK] to confirm and the file is moved to /Company Share/Manual.  

 

Folders can be moved in the same way too.  

 

2.3.5 Copy Files or Folders  

Select the file or folder and click on the [Copy] action. Then you will come to a similar screen shot as 

below.  
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Figure 20. After selecting the file and clicking the copy action. 

 

Next, navigate to the desired folder you would like to place the file (i.e. /Private/Manual). Then click on 

the [Paste] button and confirm by pressing [OK] when prompted. 

 

 

 

 

 

 

 

 

Figure 21. Navigate to /Private/Manual/ and press the [Paste] button. 

 

   

Figure 22. Click [OK] to confirm and the file is copied to /Private/Human Resources/  

Folders can be copied in the same way too.  
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2.3.6 Rename Files or Folders  

To rename a file, select the [Rename] action. The Rename window in Figure 23 will then pop up. Enter 

the new name and press the [Okay] button. 

 

Figure 23. Enter New Name to Rename the Folder  

 

Files can be renamed in the same way too. 

 

2.3.7 Edit Text Files  

First of all the file that you select to edit MUST be a text file. Normally a text file ends with extensions 

such as “.txt” or “.csv”.  

Select the file that you want to edit, then press on the [Edit] action. The Edit Window will appear as 

shown in Figure 24. You can start editing the file on the body of the Edit Window. Click on the [Save] 

button once you have competed the modification. 
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Figure 24. Edit the text file. Press [Save] to save directly to Storage Center. 

 

2.3.8 Lock and Unlock Files  

The Lock/Unlock function is only useful in Company Share folder where group sharing is available. A 

file can be locked and unlocked through this function. Generally used while a file is shared and worked on 

by a group of users.  

You can lock the file while it is downloaded for update. Once updated and uploaded you can unlock the 

file so that other users can work on it.  

 

Figure 25. Before the file is locked 
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Figure 26. Press [OK] to Lock the Checked File  

Select the file you want to lock and then click on the [(Un)Lock] action to lock the file as in Figure 26. 

Perform the same procedure on the locked file will have it unlocked. 

 

Figure 27. After the File is locked, notice that the lock symbol on the right end of the row. 

 

2.3.9 DropTo  

DropTo function is what makes the DropFile (SendFile) or DropFolder (SendFolder) feature possible. 

DropFile is essentially a solution for sending huge files via email. Instead of attaching the actual file to 

the email, DropFile embeds URL links of the files of which the email recipient will download from. With 

only URL links embedded, size of the files does not matter anymore, thus the email size remains very 

small. Hence you as a sender will not put strain on your broadband bandwidth and the SMTP server, your 

DropFile will not be rejected by the recipient‟s mail server because of the size quota, your DropFile will 

not bounce because the recipient has an inbox of limited size. Last but not least, the recipient for sure will 

not complain about slow download of your email if he/she is on POP or IMAP (Those who are using 

Outlook, Outlook Express or similar email software).  

DropFile works for both Storage Center users of the same domain and external users with an email 

address. Storage Center users of course have an added advantage which will be revealed shortly. Now let 

see how a DropFile works.  
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First, select the file(s) that you would like to drop/send. Then click on the [DropTo] action to launch the 

“DropFile/Folder” window as shown in the below figure. 

 

Figure 28. Launch the DropFile/Folder window and Enter the Email Address of the Recipient 

 

At the [To (e-mail)] field, enter the email address of the recipient. If you have more than one email 

address, separate them by comma. Optionally, you can choose how many days the file URL link(s) will 

be valid for at [This drop will remain available for]. Also if you would like to be notified once the 

recipient has downloaded the file(s), select “Yes” at [Notify me when recipient picks up file]. Now, press 

[OK] to send the file(s).  

The recipient will receive an email similar to the one in Figure 29. Clicking on the link will lead the 

recipient to a Download Page as in Figure 30.  

Note: In order to use the DropTo function, you must have your files and folders uploaded via Web 

Storage or StorageSync first. Please refer to Chapter 2.3.2 and 3, respectively. 
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Figure 29. Email Sent to the Recipient 

 

Figure 30. DroFile/Folder Download Page 

The recipient can right click on the file link (Item with blue text) to save or press the [Download] button 

to let the browser open/handle it.  

The DropBox  

If the recipient happens to be one of the Storage Center users of the same domain, he/she will be able to 

find the file(s) dropped in his/her DropBox. The number in the bracket indicates the number of files inside 

the DropBox. The recipient can click into the DropBox and accept or reject the file(s).  

Click on the [Accept] button, the recipient can choose to paste the file in any of the accessible desired 

folder as in Figure 33 (just like you would Move or Copy a file). 
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Figure 31. Drop Box  

 

Figure 32. Accepting the DropFile  

 

Figure 33. Paste the File(s) to Your Desired Folder 

 

2.3.10 Search for Files or Folders  

You can search for any files/folders through the [Search] function. 

 

Figure 34. Enter the File or Folder Name you are searching for 
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Figure 35. The Search Results 

 

2.3.11 Create Short Cuts  

On “My Storage”, click on the [New Shortcut] button.  

 

Figure 36. Click on the New Shortcut button 

Navigate to parent folder in which you want to make a shortcut for. Select the folder‟s checkbox and click 

on the [Done] button. You will be brought back to “My Storage” with the new shortcut as displayed in 

Figure 37. 

 

Figure 37. Select the folder for shortcut and click on the [Done] button. 
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Figure 38. Shortcut is created on My Storage for the selected folder. 

 

2.3.12 Encrypt and Decrypt Files  

Select the file to be encrypted, then click on the [Encrypt] button to launch the below window.  

 

Figure 39. The Encrypt Window 

Enter the passphrase twice and press [OK]. The original file will be deleted and left with the encrypted 

file now. If you still want the unencrypted version of the file, then uncheck the [Delete original file 

immediately after successful encryption].  
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If you choose to use the Encrypt function, you are responsible to remember the 

Passphrase that you entered. If you forget the Passphrase, you will not be getting back the 

original file before you encrypted. 

 

 

Figure 40. File Encrypted with the “.enc” extension after the Entire Filename  

 

Figure 41. File encrypted with the „.enc‟ extension after the Entire Filename 

To decrypt an encrypted file such as that in Figure 40, select the file and press the [Decrypt] button. The 

following window will pop up. Enter the passphrase and press [OK]. The encrypted file will be restored to 

the original state as in Figure 43. 

 



 
 

26 
 

 User Guide: AfterOffice Storage Center 

Copyright © AfterOffice.com Sdn. Bhd. All Rights Reserved. 

 

 

Figure 42. Decrypt Window 

 

 

Figure 43. The Encrypted file is restored to the Original State  

 

2.3.13 AVScan (Antivirus Scan)  

Select the file by checking the checkbox of the file. Then press the [AVScan] button run the Antivirus 

Scan.  

Note: The AVScan will only scan for viruses but will not disinfect them. All files being uploaded or 

backed through Web Storage or StorageSync will undergo the antivirus scanning. Web Storage will 

provide immediate feedback where as StorageSync will provide the full report in the Log Report.  

The [AVScan] here will be useful if you are saving attachment from AfterOffice Webmail to Storage 

Center. 
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Chapter 3: Off-site Backup with StorageSync   
___________________________________________________ 

 

StorageSync is the software developed by AfterOffice that makes the off-site and online backup possible. 

You should install StorageSync on your notebook, desktop PC, or server so that all your critical data will 

be automatically backed up off-site via the Internet. 

 

Figure 44. StorageSync will backup your Critical Data Off-site automatically 

 

3.1 System Requirements  

 Windows XP, Windows Vista, Windows 7, Windows Server 2008, Windows Server 2003, Mac 

OS, Linux.  

 At least 300Mhz CPU clock speed, 128MB RAM, and 20MB of free disk space.  

 Internet connection and a valid account for Storage Center with AfterOffice.  
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3.2 Where To Download StorageSync?  

You can go to http://www.afteroffice.com and click on the [Download] button to get to the Download 

page or simply go to http://www.afteroffice.com/download. 

 

Figure 45. Download Page for StorageSync  

 

3.3 How To Install And Configure StorageSync?  

Once downloaded the StorageSync Program, run it and let the wizard guide you through.  

 

Figure 46. Run the StorageSync Setup Program and Follow the Wizards 

http://www.afteroffice.com/
http://www.afteroffice.com/download
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Figure 47. Choose Your Destination Folder or Let Wizard Chooses  

It is advisable to keep the box checked for [Start StorageSync when Windows starts].  

 

Figure 48. Click the [Install] Button to start the Installation 



 
 

30 
 

 User Guide: AfterOffice Storage Center 

Copyright © AfterOffice.com Sdn. Bhd. All Rights Reserved. 

 

 

Figure 49. Click [Finish] to launch StorageSync  

Click the [Finish] button to launch StorageSync. Immediately, StorageSync will prompt you to setup 

account as in Figure 50.  
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3.3.1 Login Account Setup  

At this point, you should have gathered the information from AfterOffice on your 

Domain or Sub Domain, your username, and your password. If you do not have all this 

information, please contact your administrator or AfterOffice.  

The [Server] field will normally follow the format of vo.[your domain or sub 

domain].com or vo.[your domain or sub domain].com.my. Depending on your domain, it can be “.net” or 

“.net.my” too. 

 

Figure 50. Setup your Login Account 

If you are using your own domain, i.e. abc.com.my, then your login information should be: 

 Domain “abc.com.my”  Server: “vo.abc.com.my”. 

 Username “user”  Login: “user@abc.com.my”. 
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The following example in Figure 51 shows an account with Sub Domain provided by AfterOffice. 

 

Figure 51. Setup Login Account with Sub Domain from AfterOffice  

In the above example, the Sub Domain provided by AfterOffice is “company.vo.com.my” and the 

username is “david”. Therefore,   

 Sub Domain “company.vo.com.my”  Server: “company.vo.com.my”. 

 Username “david”  Login: “david@company.vo.com.my” 

Make sure you check [Save password] and [SSL login] to make things convenient and safe. Then press 

the [OK] button. If you are installing StorageSync the first time on your computer, you will be prompted 

as in Figure 51.  

StorageSync finds no profiles in the system, and therefore prompt the user about it in case he or she wants 

to perform a Restore. Since this is the first time you are installing, just click [No]. Now you are ready to 

create profiles for off-site backup. Refer to “Chapter 3.6: Create Profiles” for more details. 
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Figure 52. Click “No” if first time installing StorageSync 

 

Figure 53 Login Account Setup Successfully 
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3.4 How To Login or Change My Login Account?  

Click on [Edit] on the Menu and select [Login Info] to launch the window below. You can edit on all the 

fields. Editing the Login Info here will change the default account of your new profiles to the newly 

edited one.  

 

Figure 54. The Login Info Window  

Alternately, you can select your target profile and click on the [Browse] button of the Remote Folder to 

launch the “Browse Remote Storage” window in Figure 54. 

 

Figure 55. Click on [Browse] of the Remote Folder 

 

Next, click on the People Symbol circled in red in Figure 55 and launch the “Login Profile” window. 
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Figure 56. Click on the People Symbol Circled in Red to Launch the Login Profile  

You can now edit and change the Login Account Info for this specific profile. This is catered for users 

who have more than one domain or user account. For example, if you are the financial control for ABC 

company (abc.com.my) and the subsidiary EFG company (efg.com.my), you might want to set your 

default Login Account using “vo.abc.com.my” for [Server] to backup and share files among ABC, and 

edit some specific profiles‟ Login Account with “vo.efg.com.my” for [Server] to backup and shares files 

among EFG. 

 

Figure 57. Edit the Login Account Info for a Specific Profile 
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3.5 Menu Bar  

Menu bar has the following options:  

 File  

 Edit  

 Help  

 

3.5.1 File  

Under File you can find: Export, Import, and Quit.  

Export  

Be sure that [Automatically export to remote after settings changed] is checked so that every time after 

you made any changes to any profile, the profile will be exported/backed up to Storage Center of the 

default Login Account. 

 

Figure 58. Export profiles to Remote (Storage Center)  
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Import  

This function is required when you are trying to restore the profiles from Storage Center to a newly 

installed StorageSync. These restored profiles will then be used to restore all the data back to the original 

folder paths. 

 

Figure 59. Import Profiles from Remote (Storage Center)  

 

Quit  

To close and exit the program.  

 

3.5.2 Edit  

[Login Info] is here. For more details, please refer to chapter 3.4 “How To Login or Change My Login 

Account?”.  

 

3.5.3 Help  

Help consists of Help, Video Tutorial, Check for Update, and About.  

Help  Embedded user guide for StorageSync in HTML.  

Video Tutorial  Show you simple steps on backing up in animation.  

Check for Update  Check for the latest version of StorageSync.  

About StorageSync Version and Ownership. 
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3.6 Create Profiles to Backup/Restore/Synchronize  

3.6.1 What is a Profile?  

A Profile can represent a backup, restoration, or synchronization setting. In any setting, a profile consists 

of a local folder (i.e. a folder in your computer) and a remote folder (i.e. a folder in the Storage Center), 

the Direction setting (backup, restore, or synchronize), and other optional settings such as scheduling, 

files selection, security, etc.To create a Profile, click on the [New] button under the “Profiles” section. 

Enter the name of your profile and click [OK]. The new Profile should appear the left column of 

StorageSync as in Figure 60.  

3.6.2 Select the Local Folder  

The [Local Folder] field specifies the path to a folder in your computer. It could 

be the source of files to be backed up to server or the destination for files from 

the server. The direction setting will determine this as in Figure 61.  

3.6.3 Select the Remote Folder  

The [Remote folder] field specifies the path to a folder on the server (Storage 

Center). It could be the destination folder for the files from your computer, or the 

source of files to be downloaded to your computer. Again the direction setting 

will determine this.  

3.6.4 Select the Direction Setting (Backup, Restore, and Synchronize)  

The icon immediately to the left of the Local Folder and Remote Folder fields 

shows the selected direction setting. The computer image represents your 

computer and the globe represents the remote server (Storage Center). A green 

arrow in between shows the direction of the copy, either from local-to-remote 

folder or remote-to-local folder. A third case of two green arrows appearing, 

means bi-directional transfer. This is sometimes termed as "synchronization". In 

this case, newer files will be transferred and they may be sourced from your local 

computer or from the remote server, depending on their timestamp. So, in such a 

run, it is possible there may be file transfer in both directions. See Figure 62 for 

the 3 types of direction setting. Change the setting by clicking on the icon. 

 

Figure 61. Local/Remote Folders and Direction Setting 

 

Figure 60. Profiles 
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Figure 62. Direction Setting: Backup, Restore, Synchronize 

 

3.7 Schedule Your Off-site Backup  

Once you have created the Profile and selected the Local Folder as well as the Remote Folder with the 

desired Direction Setting (Local-to-Remote in this case for Off-site Backup), you can then schedule your 

backup by checking [Active], selecting [Daily/Weekly/Monthly], and starting at your desired time as 

shown in Figure 63. Remember to save your setting by pressing the [Save] button. Once it is saved, the 

[Save] button will be grayed out as below. 

 

Figure 63. Schedule the Backup. Remember to [Save] the Setting. 

 

Local-to-Remote Remote-to-Local        Bi-directional 

       (Backup)           (Restore)     (Synchronize) 
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3.8 Manually Run A Backup  

To manually run a backup at anytime, just click the [Run] button as in Figure 63. A “Pre-Run” window 

will launch. Click the [Auto Proceed] button if you do not have to see what the items will be backed up. 

 

Figure 64. The “Pre-Run” after a Profile is being run  

If you did not click on the [Auto Proceed] button, you would see the body of the window populated by the 

whole list of items. Those files and folders that required to backup will be noted with “Copy” under the 

“Action” column. 

 

Figure 65. The Body Populated by Items already backed up and to be backed up 
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To proceed with the backup, press the [Proceed] button and the following window will be launched.  

 

Figure 66. Transfer Progress  

Once completed, information similar to the following Figure will be displayed. [Close] the window.  

 

Figure 67. Transfer Completed 
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3.9 Backup/Restoration/Synchronization Log  

To check if everything is fine after a “Run” for backup, restoration, or synchronization, just click on the 

“Logs” tab, you will find similar report as below figure.  

 

Figure 68. Backup/Restoration/Synchronization Log  

 

3.10 Files and Folders Selection  

As mentioned earlier in 3.6.1 “What is a Profile?”, a profile also records the setting of files and folders 

selection. Click on the “Setting” tab to find the following figure.  

Here you select what files (or folders) you wish to transfer. By checking [Copy all], this means to simply 

select ALL files in the source folder to be copied. Checking [Include subfolders] makes the selection 

span all files in subfolder, and their subfolders, etc. This has the effect of selecting an entire folder and all 

its content.  

[Copy empty folder] optionally tells the program whether to copy empty subfolder or not. If unchecked, 

empty subfolders in the source will not be duplicated in the destination. 

[Copy newer files only] means to effect transfer of files that have later timestamps compared to same 

named files on the destination. This is useful to just copy files that have been updated in the source folder, 

after an earlier run has taken place. In other words, this means that only older copies in the destination 
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will be replaced with updated ones from source. Those that do not appear to be older are not replaced, 

saving run time.  

Files that are in the source but not in the destination are normally copied over if they are not excluded by 

other filtering rules. In the case of files that are in the destination but not in the source, they are normally 

left untouched. Sometimes you may want the destination to "mirror" the source folder exactly.  

 

 

 

 

 

 

Figure 69. Files and Folders Selection  

File Include/Exclude  

The File Include field is used to list filenames that you only wish to select for transfer. The [Copy all] 

option and File Include field are mutually exclusive, meaning when [Copy all] is selected, this field is 

not applicable anymore.  

The File Exclude field is used to list filenames that you wish to exclude from whatever that may be 

included before, from the File Include field or as a result of [Copy all] option.  

For example, after you delete a file in the source folder, you may want the obsolete 

copy in the destination to be deleted too. The [Delete in destination if not in source] 

option allows you to do this. (But note that this option is not applicable in case where 

the copy-direction is bi-directional.)  

Be very careful with this option as any accidental deletion of the source file that you 

need might result on the removal of the backup file in Storage Center. 
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Complete filenames are not normally used in the file include/exclude fields. These fields accept "patterns" 

that matches up to multiple filenames. For example, *.doc would match all filenames ending with ".doc" - 

matching files like "mydocument.doc", "report.doc", "resume.doc".  

The patterns use the following characters to represent wildcards.  

Wildcard pattern  What it means  

*  means to match anything number of characters.  

?  means to match any one character.  

[xy]  means to match character "x" or "y" only, where "x" and "y" and be any character.  

 

Examples:  

Example pattern  What it means  

*  matches all names!  

*.*  matches only filenames that has a dot in it.  

*.xl[st]  matches filenames that end with .xls or .xlt  

a*  matches filenames that begin with "a" or "A", matching is case insensitive.  

*.??  matches filenames that end with two-letter extension.  

myfile.mp3  matches exactly one file named myfile.mp3  

 

Multiple patterns can be specified to include more matches. Use a comma to separate each pattern.  

 

Examples:  

Example pattern  What it means  

*.com, *.exe, *.bin  means to match files ending with .com, .exe or .bin  

 

Folder Include/Exclude  

The Folder Include and Folder Exclude fields works very much like the File Include/Exclude fields but 

it applies only to folder names. Thus you can selectively include/exclude particular folder by their names. 
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3.11 Options Setting Tab  

The Options Tab lists the remaining settings controlling the behavior of the profile run. This section 

describes each of the optional setting. Most of the recommended settings are selected by default.  

 

Figure 70. StorageSync Options Tab 

 

3.11.1 [SSL file transfers] tells the program to employ Secure Socket Layer when transferring file 

content. Slight speed degradation to overall transmission speed is expected when SSL Transfer is enabled. 

Enable or disable SSL transfers, depending on the sensitivity of your data.  

 

3.11.2 [Verify after transfers] tells the program to verify that the resultant file transferred is identical to 

the original source file. Simple file-size comparison is done first and then followed by a full MD5 

checksum verification. Generally a few extra seconds will be needed at the end of a file transfer for 

verification. Very large files may take longer. It is recommended that this option is enabled to ensure data 

integrity.  

 

3.11.3 [Send log report by e-mail] will send an e-mail containing the report on the result of a profile run. 

[Only after a scheduled run] further qualifies the above setting to send a report only after an 

automatically invoked scheduled run. [Use alternative E-mail address] allows the report to be sent to 

others especially for those who are sharing files and folder. For multiple email addresses, separate the 

email addresses with commas in between.  

 

3.11.4 [Do not abort even if many errors] tells the program to continue execution even many errors 

occur.  
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3.11.5 [Encrypt and compress remote files] tells the program to encrypt and compress a copy of local 

file before copying this encrypted file to the server. The filename on the server has an extension ".enc" 

added at the end, to indicate that it is an encrypted file.  

When encrypted files are copied back down from the server to your computer, it will 

automatically be decrypted and its original filename is restored. However, in the case of 

disaster recovery, you will need to enter the password twice again in the newly installed 

StorageSync before running the restoration. Remembering the password is your 

responsibility if you choose to use this security feature.  

The password for encryption (and decryption) is entered in the two fields, [Password] and [Repeat it]. 

The requirement to repeat the password is to help ensure that you are able to recall the password later. The 

password can be optionally saved to disk and recalled automatically when the associated profile run is 

loaded.  

 

3.11.6 [Anti-Virus scan] enables the scanning of all files that are transferred for possible virus infection. 

This is done with the copy of the file on remote server using the anti-virus facility there. Files that are 

infected will be flagged as error during transfer. No file will be deleted. Please take appropriate steps to 

delete or contain the infected files to prevent their use. This feature is by no means a replacement for your 

computer‟s Anti-virus software, but a security measure on the Storage Center to prevent virus files from 

spreading among all sharing them. 

 

3.11.7 [Enable resumption of transfers] means the ability to resume a broken or 

interrupted transmission. The partially transmitted portion of a file resides on the 

destination as a filename with extension ".part". Only the remaining unsent portion of a 

file is transmitted when the profile is run again. This feature saves time and bandwidth 

since the file content is not transmitted from the beginning again. This option is enabled 

by default.  

 

3.11.8 [Use delta-transfer if possible] enables or disables a feature called "delta-transfer". This is 

another time and bandwidth saving feature especially for cases when there are large files being 

transmitted regularly, but each update contain only small amount of changes (delta) within the file. Delta-

transfer analyzes the earlier transmitted copy of a file in the destination and determines the parts that 

differ from the updated copy in the source. Then only the differing parts (delta) from the source file is 

transmitted, while the remaining parts are constructed from the old file that is already in the destination. A 

little extra processing time is needed to analyze the source and destination files to determine their 

differences. This time is usually well spent because the time to transmit just the differences is much 

shorter than it would take to transmit the whole file again from start. 
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3.12 How Do I Restore My Data?  

You will first need to install StorageSync on your new computer or system, and setup the Login Account. 

Follow steps from the beginning of Chapter 3 until you reach Figure 52 or the following figure. 

 

Figure 71. Click [Yes] to Restore all your StorageSync Profiles from Storage Center  

 

3.12.1 Restore Profiles  

At the prompt as in Figure 71, click [Yes] to restore Profiles from Storage Center (the remote server). 

 

Figure 72. Click [OK] to restore the Profiles 
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Then proceed by clicking [Yes].  

 

Figure 73. Click [Yes] to proceed  

Once profiles successfully restored or imported, click [Close this Program] and start StorageSync again. 

 

Figure 74. Successful Profiles Import. Restart StorageSync. 

Once StorageSync is up again, you will find all your profiles are back to the Profiles Window at the left 

column just like the following figure. 
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Figure 75. All Profiles Restored at the Left Column  

 

3.12.2 Set the Profile to Restore Mode  

Now, for each specific backup profile that you want to restore, you must change the Direction Setting 

from Local-to-Remote (Backup/Upload) to Remote-to-Local (Restore/Download). 

 

 

 

 

Figure 76. Change Direction Setting from Backup to Restore 

 

For profiles that are originally and already in Bi-Directional Setting (Synchronization), just [Run] will 

restore all files and folders of that profile. 

 

Local-to-Remote    Remote-to-Local         

       (Backup)                        (Restore)      
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3.12.3 Start the Restore Process  

Now press the [Run] button to start the restoration.  

 

3.12.4 Change Direction Setting back to Backup Mode  

Once the restoration of the files and folders is completed, you must remember to change the Direction 

Setting back to Local-to-Remote (Backup Mode) so that your data will be continued getting backed up 

off-site and protected.  

 

3.13 Video Tutorial for Backup with StorageSync  

Go to http://www.afteroffice.com/download to look for the following link:  

 

Figure 77. Video Tutorial for StorageSync 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.afteroffice.com/download
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Chapter 4: Files and Folders Sharing with StorageSync    
___________________________________________________ 

 

4.1 Share Files and Folders From One To Many, Many To One, and One To One  

 

4.1.1 One To Many: To share folders and files with a group of company members where you would  

update the content of the files and folders, and most would just download and view.  

This is applicable to the following scenarios:  

1) A Sales Manager who constantly updates the sales kits with latest pricing and promotional flyers and 

brochures, and the Sales Team which requires them on the daily basis.  

2) The Headquarter which needs to share most updated documents with the multiple branches over the 

country or the globe.  

3) The Principal which needs to update on the distributors or resellers on the latest products information 

and pricing, as well as the promotions.  

 

4.1.1.1 One: Direction Setting at Local-to-Remote (Backup/Upload)  

 

Figure 78. Make Sure the Direction Setting, for the “One” individual, is Local-to-Remote 

In this case, the Sales Manager (One) will only need to update any files and folders under his computer 

D:/afteroffice/sales/Kit. The Remote Folder will be updated daily as scheduled, and any updates will be 

available for the Sales Team (Many). 
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4.1.1.2 Many: Direction Setting at Remote-to-Local (Restore/Download)  

All the Sales Team (Many) need to do is to make sure the Direction Setting is correctly configured like 

the below figure. Their Local Folders will be updated as scheduled every morning at 8am.  

 

Figure 79. Make Sure the Direction Setting, for the “Many” individuals, is Remote-to-Local 

 

4.1.1.3 Email Notification  

By default under the Options Tab, you will be getting an email notification of the Logs after every 

scheduled run. However, if you like to get the email notification after all runs (manual or scheduled), just 

uncheck [Only after a scheduled run]. 

 

Figure 80. Email Notification at the Options Tab 

 



 
 

53 
 

 User Guide: AfterOffice Storage Center 

Copyright © AfterOffice.com Sdn. Bhd. All Rights Reserved. 

 

As long as [Send log report by e-mail] is selected, you will be getting an email notification at your default 

email address.  

[Use alternative E-mail address:] when you would like to receive the Logs in an alternate email address. 

Furthermore, if you would like to the rest of the team to know that something has been updated, you can 

also have your whole team‟s email addresses entered in the field. Separate the email addresses with 

comma. Make sure you [Save] the changes of the settings. 

 

4.1.2 Many To One: To be able to view updated files and folders from different groups. This is applicable  

to the following scenarios:  

1) A Business Owner / CEO / Manager who needs to read up reports from the Managers / Sales Teams / 

Production, etc.  

2) The Secretary / Personal Assistant who needs to compile reports from different sources and submit to 

the CEO, etc.  

4.1.2.1 One: Direction Setting at Remote-to-Local (Restore/Download)  

A CEO might want to just receive and read the management reports from his management teams, 

therefore the Direction Setting should be Remote-to-Local (Download). 

 

Figure 81. CEO receiving Management Reports from the Management Teams 
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The CEO should take note that the files and sub folders under the Local Folder (in the 

figure above the Management Reports folder) will be constantly be updated or replaced 

with the content by his management teams. Therefore if the CEO would like to keep a 

copy of all the files and folders of today, to make sure the reports will not be altered or 

changed by anybody, he or she would have to copy and paste the Management Reports and  

rename it i.e. Management Reports 11-Nov-2010. Do NOT save the new folder under the Management 

Reports folder. 

 

4.1.2.2 Many: Direction Setting at Local-to-Remote (Backup/Upload)  

In this example, the Sales Manager, representing the “Many”, has set the Direction to Local-to-Remote 

(Upload) in order to upload and share his/her reports with the CEO or directors. Every time after a 

scheduled or manual [Run], the CEO or directors will receive an email notification (the Logs) informing 

which file has been updated, so the CEO or directors can choose to manual [Run] the Management 

Reports Profile to get the update.  

Once the CEO‟s [Run] is completed, he/she will be informed by email as to which file in his/her local 

Management Reports folder has been modified or newly created. 

 

Figure 82. Sales Manager Sharing Sales Reports to the CEO or Directors 
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4.1.2.3 Email Notification  

Please refer to 4.1.1.3 

 

4.1.3 One To One: To share files and folder with specific individual(s) via Storage Center‟s Private Folder.  

Before these individuals are able to share via the Private Folder, they will need to setup the intended 

Network Share Folder, which is explained in Chapter 6.3. This is applicable to the following 

scenarios:  

1) The Secretary / Personal Assistant who submits to the CEO reports compiled from multiple sources.  

2) The CFO who needs to share financial reports with the CEO and COO.  

 

Figure 83. One-To-One Individual Sharing with Private Folder in Storage Center 

 

4.1.3.1 One: Direction Setting at Local-to-Remote (Backup/Restore)  

Take the example of the CFO who needs to share financial reports with the CEO and COO. The settings 

will be like the one in Figure 78, where the Direction Setting is Local-to-Remote (Upload), and email 

addresses of the CEO and COO are entered into [Use alternate E-mail address]. 
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4.1.3.2 The Other One(s): Direction Setting at Remote-to-Local (Restore/Backup)  

Continue with the previous example, the CEO and COO will need to configure the Direction Setting the 

other way around, to the Remote-to-Local, to be able to download reports generated by the CFO. Also, 

the Remote Folder for the CEO and COO will be under the Network Share/Finance or Network 

Share/[folder name given by the CFO]. Please refer to Chapter 6.3 for more details on Network Share.  

 

Figure 84. Setting of the CEO and COO to Receive Files Updates via Network Share  

 

4.1.3.3 One-To-One Synchronization  

If the CFO has granted both READ and WRITE access to the CEO and COO, the sharing could be both 

ways, and therefore the Direction Setting can be at Bi-Directional or Synchronization.  

 

4.1.3.4 Email Notification  

Please refer to 4.1.1.3  
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4.2 Share Files and Folders Among All  

If everybody needs to be able to read and write in a shared folder, then Bi-Directional or Synchronization 

is the way to go. 

 

4.2.1 Direction Setting at Bi-Directional (Synchronize)  

 

Figure 85. Sharing files and folders with Synchronization  

 

4.2.2 Email Notification  

Please refer to 4.1.1.3 
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Chapter 5: Access Storage Center Via WebDAV    
___________________________________________________ 

 

5.1 Understanding of WebDAV  

You can use Microsoft Web Folders, Mac OS WebDAV or Linux Korqurer 

browser to open your folders in the AfterOffice Storage Center, right from 

your desktop. Using a WebDAV client, you may drag and drop a file or a 

folder from your local folder to your web folder on AfterOffice Storage 

Center or vice versa.  

 

 

5.2 Setup Web Folder on Windows Explorer  

 

Create a Web Folder in Windows 98 or Windows NT  

1. In Windows 98 or NT, right click on the 'My Computer' icon on the desktop and then left click on 

'Explore'.  

2. Windows Explorer will open.  

3. Locate 'Web Folders' in the left directory listing.  

4. Click on 'Web Folders'.  

5. Double click on the 'Add Web Folder' icon in the right directory listing.  

6. Enter the location of the AfterOffice at this URL: http://vo.afteroffice.com:8085  

7. Click 'Next' to continue.  

8. A window asks for your user name and password. Enter your email address and password.  

9. Check the 'Save this password' box for future use.  

10. Enter a name for this Webfolder like “AfterOffice Storage Center”.  

11. Click 'Finish'.  

12. A Web folder named “AfterOffice Storage Center” is now created and ready for use.  

13. To access it, double click on it.  

 



 
 

59 
 

 User Guide: AfterOffice Storage Center 

Copyright © AfterOffice.com Sdn. Bhd. All Rights Reserved. 

 

14. Please note: you create a shortcut of this folder on your desktop.  

15. All your documents are now accessible by double clicking, drag and drop.  

 

Create a Web Folder in Windows 2000 - Me  

1. In Windows 2000, right click on the 'My Computer' icon on the desktop and then left click on 'Explore'.  

2. Windows Explorer will open.  

3. Locate your 'Network Places' in the left directory listing.  

4. Click on 'My Network Places' in the left directory listing.  

User Guide: AfterOffice Storage Center Copyright © AfterOffice.com Sdn. Bhd. All Rights Reserved. 66  

5. Double click on 'Add Network Place' in the right directory listing.  

6. Double click on the 'Add Web Folder' icon in the right directory listing.  

7. Enter the location of AfterOffice Storage Center at this URL: http://vo.afteroffice.com:8085  

8. Click 'Next' to continue.  

9. A window asks for your user name and password. Enter your email address and password.  

10. Check the 'Save this password' box for future use.  

11. Enter a name for this Webfolder like “AfterOffice Storage Center”.  

12. Click 'Finish'. Your web folder is created.  

13. To access it, locate 'My Network Places' with Explorer and double click on it. Your folder 

“AfterOffice Storage Center” is there.  

14. Double click on “AfterOffice Storage Center” and provide your login and password.  

15. Check the 'Save password' for more convenience.  

16. All your documents are now accessible by double clicking, drag and drop.  

 

Create a Web Folder in Windows XP  

1. In Windows XP, click on 'Start' right-click on start and then select 'Explore'.  

2. In the left panel of the explorer, select 'My Network places'.  



 
 

60 
 

 User Guide: AfterOffice Storage Center 

Copyright © AfterOffice.com Sdn. Bhd. All Rights Reserved. 

 

3. In the explorer's right panel, select 'Add network place'.  

4. When prompted, 'Where do you want to create this Network Place?', choose 'Choose Another Network 

Location' and click on 'Next'.  

5. In the 'Add Network Place Wizard', follow the instructions to add a shortcut to AfterOffice at this URL: 

http://vo.afteroffice.com:8085  

6. When prompted for a user name and password, type in your email address and password.  

7. Click 'OK'.  

8. Next, name your Network Place like “AfterOffice Storage Center”.  

9. When you have successfully added the shortcut, an icon for your new shortcut will appear in the My 

Network Places directory.  

10. All your documents are now accessible by double clicking, drag and drop.  

 

The following is a step by step guide on setting up to use AfterOffice Storage Center as a Web Folder:  

(Under Microsoft XP). Use your browser to mount your Storage as Web Folder, open browser first (IE), 

and select Open from the File Menu as shown in Figure 85.  

 

Figure 86. Select File>Open on your web browser 
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A dialog box will appear as shown in Figure 87 after you have performed as instructed in Figure 86. Type 

the full URL to the VO server, in this case:  

http://vo.afteroffice.com:8085/ 

 You can also use your own domain for this:  

http://vo.yourDomain.tld:8085/ 

where yourDomain.tld is the real domain with AVO. Check the box for “Open as Web Folder” and click 

OK.  

 

Figure 87. Type the full URL to the VO server on the given field 

After you have completed the above a dialog will appear as shown in Figure 88 Type your full email 

address in the "User name:" column. And proceed with your AVO password. Click OK when done. 

The WebDAV client will attempt to connect to the Storage server. The Storage directory will be shown as 

follow:  

  

Figure 88. Key in your full email address and password to connect to the server 

http://vo.afteroffice.com:8085/
http://vo.yourdomain.tld:8085/
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A shortcut to this Web Folder will be available in the "My Network Places". You have successfully 

enabled the Webdav client to connect to the Storage Server. You may double click on the shortcut to 

bring you to your Storage Center on the web. 

 

Figure 89. The Web Folder shortcut in “My Network Places” 

 

Known limitations  

 Opening a document by 'double-clicking'. If your PC/Mac operates using Office 2000 or later, 

documents of the type Word (.doc), Excel (.xls), PowerPoint (.ppt) located on your virtual disk 

can be opened by a double-click on the file. You can therefore modify and save them directly to 

the server. If your files do not open automatically with a double click, you must save them to the 

hard disk of your machine (using 'drag and drop') before you can open and modify them. Similarly, 

you will need to copy them to your virtual disk after you have made any changes.  

 Sharing documents within a group. If you place a document within a group, by accessing your 

virtual disk, this document will not be automatically shared and accessible by all group members. 

To make it accessible by any or all group members, you must login using the usual web interface, 

and set the access/sharing rights. This problem will be corrected in a subsequent version.  

 Strange files with MacOS. With MacOS, uploading a file to the Webfolder creates a duplicate file 

starting with '_'. We are working to resolve this problem.  

 



 
 

63 
 

 User Guide: AfterOffice Storage Center 

Copyright © AfterOffice.com Sdn. Bhd. All Rights Reserved. 

 

Security - Encryption during transfer  

 Disconnecting. The connection to you Webfolder is active only as long as you are connected to the 

Internet and your computer is on. To close the connection manually, right click on 'My computer' 

and choose 'Disconnect a network drive'. Select the network drive that corresponds to your 

Webfolder and click 'OK'.  

 SSL. If you want all your communications with your web folder to be encrypted (SSL), you simply 

need to create a web folder using the following standard procedure but using 'https' instead of 'http' 

(e.g. https://vo.afteroffice.com:8085 instead of http://vo.afteroffice.com:8085). Please note: 

encrypted communication can take up to 2 times longer than non-encrypted communication.  

 

Access rights  

 All access rights defined using the web interface are applicable to your virtual disk. In other words, 

if you have not permitted one of the members of your groups to see a folder or document, then the 

particular folder or document will not been seen by this member on the virtual disk.  

 

5.3 Video Tutorial for Access Via WebDAV  

Go to http://www.afteroffice.com/index.php/webdav and click on the following link: 

 

Figure 90. Video tutorial for WebDAV 

 

 

 

 

 

 

 

 

 

http://www.afteroffice.com/index.php/webdav
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Chapter 6: 3 Ways to Share Files With Storage Center    
___________________________________________________ 

 

6.1 Share via Company Share Folder  

As mentioned earlier at the very beginning, the Company Share Folder is the common folder where all the 

Storage Center users can access and share files and folders. However, the Administrator (avomaster) is 

able to setup the access permission to allow certain groups of user to open or view certain folders, 

enabling a more secure and control environment for collaboration.  

 

6.1.1 Setup Folders with Group Access Rights  
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Figure 91. Setting Up A New Folder for the HR Group 

 

The example in Figure 91 shows how the Administrator (avomaster) creates a new folder for the 

Marketing group of the company to share and collaborate. Only members of the Marketing group will be 

able to perform the listed tasks, under the Access Control, on the Marketing folder, except for a few 

critical tasks such as “Delete Folder”, “Rename Folder”, and “Delete Files in Folder”. 

 

Figure 92. The Human Resource Folder Created under Company Share 

 

6.1.2 The use of Lock and Unlock in Company Share  

When sharing or collaborating on the same file, you and your team might want to take advantage of the 

(Un)/Lock feature as it is one handy way to make sure that while you are making changes on the file, 

nobody will be able to perform any update to the file that you have Locked. If other users would like to 

update it, they will have to wait until you have unLocked the file. Then only should the next user Lock 

and download the file for editing. For more details on how to use the feature, refer to Chapter 2.3.8 “Lock 

and Unlock Files”.  
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6.2 DropFile and DropFolder using DropTo Function  

This feature can be applied to both Storage Center and external users. Instead of emailing with file 

attachment, the email contains only links that allow the recipient to download the files intended to share. 

Storage Center users have the added advantage of receiving the files in their Dropbox and moving them to 

their desired folders.  

 

6.2.1 Solution for Sending Huge File  

Email is still the most popular Internet communication tool, however the problem starts to arise when you 

are attaching huge file to the emails. Most corporate mail servers set the maximum incoming or outgoing 

email size at 10MB. Any size above that will be rejected. 

Some email users might not have huge mailbox or their mailboxes are so full that even a tiny email with a 

1MB attachment might get bounced. Also, to download a huge email with a mail client (through POP or 

IMAP) can be rather annoying to the recipient as the recipient will have to wait until the big email is 

downloaded before he/she can start receiving those probably even more critical emails at the back. Worse 

is if the Internet has some intermittent disconnection, then the recipient will have to go through the same 

agony of downloading the big email.  

Hence DropFile and DropFolder present a solution for sending huge file. For more details on how to 

perform a DropFile or DropFolder, refer to Chapter 2.3.9 “DropTo”.  

 

6.2.2 Solution for Sending Encrypted Huge Files  

If you would like to tighten the security of the file(s) being Dropped, you could first encrypt the file with 

Storage Center Encryption tools (refer to Chapter 2.3.12), then perform the DropFile with DropTo (refer 

to Chapter 2.3.9).  

The password for the encryption/decryption can be sent via our WebSMS if you have subscribed it. 

Otherwise, you could just do it via your mobile sms or over a phone call.  

The email recipient of the DropFile will receive and download a file with a “.enc” extension. The 

recipient will have to follow some easy steps below to decrypt your file. 

To decrypt a .enc file from AfterOffice.com:  

1. Save the .enc file in your desired folder.  

2. Download GnuPG Software (Windows version) from http://afteroffice.com/download  

3. Install the software accordingly and run it.  

4. Click on 'Files' at the menu icons to launch the File Manager.  
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5. Click on 'Open' to browse for your .enc file saved at your desired folder.  

6. Another window will pop up and the .enc file selected. Next click on 'Decrypt'.  

7. You will be prompted for the passphrase. Key in the passphrase.  

8. The original file will be saved under the same folder.  

GnuPG is provided by http://www.gnupg.org/ 

  

6.2.3 Dropbox in Web Storage  

Storage Center users will also get to receive DropFile(s) in the Dropbox besides receiving the email. To 

see how you can retrieve your DropFile in your Dropbox, refer to Chapter 2.3.9. 

 

6.3 Network Share  

Network Share allows you to share any folder under your Private Folder with specific individuals. This is 

often used for sharing more confidential information between or among different individuals. For example, 

the CEO and CFO might require a private space for sharing files and reports while other staff of different 

departments need to collaborate on a campaign which require the sharing the images and documents. 

Network Share works perfectly for both scenarios.  

 

6.3.1 View the Private Sharing Folders  

To see all the folders being shared to you by others, click on [Network Share] 

 

Figure 93. Privately Shared Folders under the Network Share  

http://www.gnupg.org/
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To view who share the private folder to you, click on the Item Property         , which is on the same row to 

the shared folder. The information of the shared folder will be displayed in the Item Property window. 

You can find out who the owner is and what access rights have been granted to you as shown in Figure 93. 

 

Figure 94. Item Property of a Privately Shared Folder  

To get an overall view of who is sharing what folder with you, click on [Shared Items]  [Items from 

Others] 

 

Figure 95. Shared Items Showing All folders being shared to and from you 

 

6.3.2 Create Network Share Folders  

To share a folder privately with other specific individuals, you will need to create a Network Share Folder. 

First go to your Private Folder, and click on the Item Property of the desired folder to be shared privately. 
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Figure 96.  Click on the Item Property        of the Desired Folder to Share  

Next, enter the email address of the specific individual on Storage Center into [Shared to], grant [Read], 

[Write] access or both. Then click [Update Sharing]. This individual should be on the same domain (i.e. 

afteroffice.com in the following example). 

 

Figure 97. Enter the Email Address of the Specific Individual 

Once updated, your folder will look like the following figure.  

 

Figure 98. Privately Shared Folder  

To view what private folder you have shared with who, click on [Shared items] and you will be looking at 

[Items from Me] as in figure below.  
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Figure 99. Private Folder Shared from You to Others 

 

6.3.3 Receive/Reject Network Share Folders  

Private folders shared to others will appear immediately under their Network Share Folder. The receiver 

of a private shared folder will be informed via email too. 

 

Figure 100. Email Notification on New Network Share Folder 

If you are using AfterOffice Webmail, you will be able to go directly to the Network Share folder by 

clicking on the link [Click here to go to your Storage Network Share].  

To stop sharing the private folder to any specific individual for example in Figure 99, click on the Trash 

Can and click [OK] on the confirmation below. 

 

Figure 101. Click [OK] to Confirm  

To reject a private folder being shared to you by other, click on 

the Trash Can as well then click [OK] to reject. 
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Chapter 7: Convenient Features for the Public    
___________________________________________________ 

 

Storage Center has installed features that allow the public, such as your customers, business associates, 

your vendors to share files with you, and vice versa.  

 

7.1 Public Link for External Users to Download Files  

Earlier we have mentioned about the Company Homepage folder as well as the Private Homepage folder. 

All the files stored under both folders can be viewed by the public via a URL link.  

[Company Homepage] folder is only accessible to the Administrator (admin) of your company (domain). 

The Administrator can build a company related homepage here. Link to this homepage is:  

http://vo.[yourdomain].com/storage/homepage/[yourdomain].com/index.html  

or  

http://vo.[yourdomain].vo.com.my/storage/homepage/[yourdomain].vo.com.my/index.html.  

Alternately, a public link for a file or image can be generated by replacing “index.html” with the file name.  

For example, if you have a file called icon_Living1.JPG under /Company Homepage/property/CasaDesa/, 

you just have to replace the “index.html” with /property/CasaDesa will do, as shown in Figure 102 and 

102.  

 

Figure 102. Get the Name of the File that you would like to publish 
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Figure 103. The Public URL Link for View or Download 

 

[Private Homepage] folder is where the user can upload his/her private homepage. Although the whole 

world can see your homepage, only you can manage and alter its content. Link to this home page is:  

http://vo.[yourdomain].com/storage/homepage/[yourdomain].com/~username/index.html  

or  

http://vo.[yourdomain].vo.com.my/storage/homepage/[yourdomain].vo.com.my/~username/index.html.  

Alternately, a public link for a file or image can be generated by replacing “index.html” with the file name. 

 

7.2 Public Link for External Users to Upload Files  

While you are able to send huge files easily with DropFile to your customers, business partners, etc, are 

they able to do so with their current email system? Most email server will set a limitation of how big a file 

can be attached to the email. If that is the case for your customers, then with Storage Center you can 

create a Public Link for Upload, and send this URL link to your customers, or have this URL link on your 

website. Your customers will be able to upload huge files to your /Company Share/Incoming/ folder or 

sub folders.  

The following steps will guide you how to create a Public Link for Upload:  

Step 1. Login with your avomaster account or the voadmin account. Normally, step 2 and 3 has already 

been performed by default. If so, then just move on to Step 4. 

Step 2. Go to [Profile]  [Admin Tasks]  [Group] and create a new group named “guest”.  
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Step 3. Enable the “guest” group at [use as Group in UCAR” as shown in Figure below.  

  

Step 4. Go to [Profile] -> [Admin Tasks] -> [Account] and click [New]  

 

Step 5. Enter the preferred username or “customerupload”. Check [Edit profile after account created] then 

click the [Create] button. 

 

Step 6. Click on [# more] link to expand the groups.  
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Step 7. Select [guest] so the user account belongs to a member of this group. Click [Update].  

  

Step 8. Now, go to [Storage]  [Company Share] and create a new folder named “Incoming”. Do NOT 

click on [CREATE] yet.  

 

Step 9. Check on the access control task for “guest” group accordingly as below. Now, you can press the 

[CREATE] 
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Step 10. Now, go to [Profile]  [Admin Task]  [Public Access] to setup the access point like below. 

Enter your preferred [Access name] or just follow below. [As user] has to be “customerupload”, and 

choose “File Upload – Company Share/Incoming” as highlighted in the figure. Click [New] and look for 

“Customer Upload” in the Access Name list. 
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Step 11. If you are using Firefox, right click on the Access Name [Customer Upload] and select [Copy 

Link Location]. If you are using Internet Explorer, the equivalent function is called [Copy Shortcut]. 

 

With the link that you have just copied, you can save it in a text file and store it in your Storage Center. 

Email to your customers or business associates when they need to send you huge files but email has failed.  

Alternately, you can also put the link up on your website where your customer and business associates 

can easily click on and come to the upload page like below. 

 

 

 

 



 
 

77 
 

 User Guide: AfterOffice Storage Center 

Copyright © AfterOffice.com Sdn. Bhd. All Rights Reserved. 

 

Chapter 8: User Control Access Right (UCAR)    
___________________________________________________ 

 

8.1 Understanding of UCAR  

In order to make sure the data is protected from being accessible by everybody or to specific groups of 

people, access rights control is necessary. In AfterOffice Storage Center, we have UCAR which stands 

for User Control Access Rights. UCAR allows the Storage Center administrator to determine which 

group of users can access the Storage Center application and the default folders as well as the sub folders. 

In additional, the administrator can also determine which group of users can perform certain actions on 

each folder.  

Once you logon to your Virtual Office or Storage Center portal, you will see the following menu items. 

Don‟t get worry if you do not see all of them below. The important ones that you should at least have are 

[Profile] and [Storage].  

 

8.2 Create User Accounts for Storage Center  

 

When you click on the Profile menu item, it will lead you to the following screen. If you are the 

avomaster or have the voadmin privilege, you should be able to access the „Admin Tasks‟. If not, please 

refer to the User Manual for VO AVOMaster 1.1.PDF file at AfterOffice Support Documentations, 

or click on the following link: http://afteroffice.com/index.php/support/documentations. 

 

http://afteroffice.com/index.php/support/documentations
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Once you are have accessed „Admin Tasks‟, the following step-by-step instructions will guide you 

through the configuration of the Group Administration and UCAR settings for the Menu Items, Storage 

Default Folders, and the Company Share Folder along with its sub folders. However, as the Administrator, 

it is your responsibility to test out thoroughly on all the group access for all folders and sub folders that 

you like to customize for a particular group of users. AfterOffice provides the two default groups, namely 

the voadmin and user.  

Step 1. Create All the Users 

The default landing page is „Account‟, which is where you will create all the user accounts.  

 

Clicking on the „New‟ button will lead you to the following page. This is where you enter the username 

and password of the individual user. As you can see, the two default groups, voadmin and user are 

present. If you would like the user to become the Admin, check voadmin. For a general company 

members, check only user.  
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Note: If you are creating a user for external group, do NOT check on any of the recommended groups, as 

that would allow the external users to access your company files. You will have to create a different group 

for the external users. 

 

8.3 Create the UCAR Group  

Step 2. Create All the Groups  

Click on „Group‟ under Admin Tasks on the left most column, you will be led to the following page. 

 

This is where you will create all the groups you need and where you will select the users who belong to 

those groups. At the bottom of the Group column (second left column), you will find a field where you 

enter the group name and a „Create‟ button to create as shown in the following image. 

Once you have created the group and selected all the members, make sure you 

check the „Enabled‟ button on top so that this group will show up on the 

following steps that you will perform. 
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8.4 Group Access Rights for the Storage Center Module  

Step 3. Configure UCAR for Menu  

Next click on „UCAR‟ under Admin Tasks, then click „Menu‟ under Modules, you will see the Menu 

Items as displayed below on the right side. The „Storage‟ row shows all the groups (checked) which can 

access the Storage Center Application. So if you have a group that you want to be able to access Storage 

Center, make sure you check it and save the configuration. The group user is by default selected for all 

Menu Items.  

 

As for external groups, you will need to provide them access to at least a few Menu Items such as  

i. Storage  

ii. Logout  

iii. Help  

iv. Profile (if you want to allow the external user to change his/her password)  
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8.5 Group Access Rights for the Default Folders  

Step 4. Configure Group Access for Storage Default Folders  

Now click on „Storage‟ under Modules, and you will see all the Default Folders in Storage Center and 

which group can access them. 

 

For external groups, you will need to allow them to have access to the Company Share, so you can create 

a folder there which the external groups can collaborate with your company groups.  

Note: Company files should NOT be stored directly under the root of Company Share Folder as they will 

be exposed to the external groups. 
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8.6 Group Access Rights at the Company Share Folder  

Step 5. Configure Group Actions for Company Share Folder (default folder)  

The group actions are the actions the selected groups can perform at the Company Share Folder. 

 

Click on the blue round icon with an „i‟ in the middle, at the same row of /Company Shar e/, you will 

come to the following page. As you can see, there are 8 tasks a group can perform. You will have to be 

very careful which group can perform these tasks.  

„Update UCAR Setting‟ is the most critical one which should be strictly controlled by voadmin only. The 

selected group will be able to control which group can perform the tasks. The following example shows 

you the flexibility of the system which allows you to appoint any other group to perform this task as well. 

Therefore, be very careful with the group selection for this task. 
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Step 5.1 Actions and Access Control under Items Properties (Company Share Folder)  
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Step 6. Configure Group Actions for Sub-Folders under Company Share 
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Finally, at the sub folder level (all folders under Company Share), clicking on the blue round „i‟ icon, you 

will see the above screen. For sub folders‟ properties, there are 12 tasks that can be performed by selected 

groups. Once you have decided the tasks to be performed by the groups, make sure you test it thoroughly 

before going live especially when involving external groups. 
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Chapter 9: Optional Modules for Storage Center    
___________________________________________________ 

 

9.1 Webmail  

The professional webmail is highly integrated to the Storage Center. Email attachment can be easily saved 

to the Storage Center. You will also be notified of any newly created Network Share folder being shared 

to you, and there will be links that allow you one click to get to the particular folder. 
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9.2 Bulk Email Marketing (BEM)  

 

BEM allows you to send hundreds of thousands of promotional emails or newsletters at one shot without 

bringing down your email servers or getting suspended by your email service provider.  

The BEM is integrated with Storage Center in such a way that BEM is able to allow you to select the 

contact list file (in CSV format) from your Private or Company Share folder. Similarly, marketing 

brochures or files can also be attached from your Private or Company Share folder.  

A practically scenario is where the Sales Team can upload their contact list from their desktop or Private 

Folder (or Company Share) while attaching the brochure, from /Company Share/Brochure, which is 

prepared earlier by the Marketing Team. 
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9.3 E-Catalog  

 

This is an electronic catalog display system that allows the website owner to 

display and promote their services or goods on the Internet. Visitors to the 

merchant's site can browse, search, and make enquiries.  

The owner can change or update the pricing, description, information, 

display priority, pictures and so on of the product any time, through a web 

based control panel. Besides immediate updates on your website's product 

page, you will also save a fortune having hire web designer or webmaster to 

perform frequent updates.  

 

The e-Catalog is required to run on top of the Storage Center, as all the images of the products will be 

kept under the Company Homepage folder. StorageSync, in this case, will help you to upload your images 

in one go to the Company Homepage folder once you have done organizing the folders and product 

images according to your categories. 
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9.4 WebSMS Marketing (Bulk SMS)  

Companies and Individuals who wants to stay in touch with their staff and customers for regular updates 

of information such as announcements, stock quotes, price alerts, news headlines, exchange rates, product 

availability, sales & marketing campaigns promotional activities etc, can easily do so whenever the users 

are connected to the net. 
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9.5 Calendar Sharing with Email/SMS Reminder  

Manage your private and group schedules efficiently and prioritize your work. Create and share calendars 

with various project teams or departmental personnel. Coupled with the WebSMS, you can step up your 

customer relationship management by periodically remind your customers of the necessary maintenance 

to their benefits, events or appointments. 
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Chapter 10: Frequently Asked Questions    
___________________________________________________ 

 

10.1 How to prevent someone in the same group from modifying a file while I am editing it?  

Before you download or start editing the file, make sure you have Locked the file (refer to Chapter 2.3.8 

on how to Lock a file). That will ensure that nobody besides yourself can update that particular file as 

long as you keep it Locked.  

 

10.2 How secure is Storage Center?  

We setup our own proprietary firewall, which is not commercially available; hence nobody knows how it 

operates except us.  

Your login username and password are all transferred via SSL which is what all the banks use for their 

Internet banking customers.  

Furthermore, we provide built-in encryption/decryption feature for your data privacy as another layer of 

security (refer to Chapter 2.3.12). However, you will have to remember the passphrase for encryption as 

AfterOffice will not be able to restore the encrypted files to their original state.  

We practice server redundancy at AfterOffice, therefore there is always fail-over storage servers backing 

up the Storage Center Servers. The server backup is performed on a daily basis.  

All servers are located at world-class data centers spread around Klang Valley.  

 

10.3 Does StorageSync come in MAC or Linux version?  

Yes. You can download them from afteroffice.com/download.  

 

10.4 How do I backup my Outlook emails (PST files)?  

Microsoft Office Outlook program stores all its data in special files called Personal Folders with .PST file 

extension. The data files are used by almost all version and editions of Outlook products, including 

Outlook 2000, 2002 (XP), 2003 and 2007. The .PST files are hidden inside a deep rooted nested folder 

under respective user directory. Below are 2 options to locate your Outlook PST files.  
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Option 1: For Outlook 2007 and previous versions  

If you‟re using Outlook 2007, simply go to File menu, then select Data File Management. You will see a 

list of all data files used by Outlook, including archives, if any. Simply click on the data file you want to 

know its location path, and then click on Open Folder… button. A Windows Explorer window will open 

and go directly to the storing folder.  

Select 'File | Data File Management...' from the menu in Outlook  

 

Double click on the 'Personal Folders'  

A Dialog Box for Personal Folders will be launched. Select the Filename and Copy (Ctrl-C or right click 

and select copy).  

Create a Profile by the name of “Outlook” (or any name you are comfortable with) in your StorageSync, 

and make sure the Green Arrow Direction setting is Local-to-Remote by moving the mouse over it.  

Now you can paste the Filename at the Local Folder field of StorageSync as the source folder to backup 

(refer to Chapter 3 for more details). However, please remove “Outlook.pst” at the end after pasting to the 

Local Folder. User Guide: AfterOffice Storage Center Copyright 

 

Options 2: For Outlook 2010  

File-> Account Settings-> Account Settings-> tab Data Files (Outlook 2010). Then follow the same 

procedure as the Double click on the 'Personal Folders'.  



 
 

93 
 

 User Guide: AfterOffice Storage Center 

Copyright © AfterOffice.com Sdn. Bhd. All Rights Reserved. 

 

 

 

10.5 How do I backup my Outlook Express emails (.dbx files)?  

Outlook Express stores emails in .dbx files and there might be several different dbx files depending on 

how many email folders you have created in Outlook Express. If you are using Windows 98, you can 

probably locate your emails somewhere in the Windows directory. In Windows 2000 and XP, emails are 

usually stored somewhere in the user data or application data folder. The easiest way to find out exactly 

where your emails are stored is to start Outlook Express, go to the [Tools] menu, and open the [Options] 

dialog box. In the Options dialog box, select the [Maintenance] page and click the [Store Folder] button. 

Here you can find the path to the folder containing your emails.  

To backup the folder, create a new Profile in StorageSync and name it „My Outlook Express‟ or „My OE‟. 

Then copy the path of the folder that you have found and paste in the [Local Folder] field of the 

StorageSync. As for the *Remote Folder+, create a new folder by the name of „My Outlook Express‟ or 

„My OE‟ under your Private folder and select this new folder. Make sure the Direction Setting is Local-to-

Remote or Backup, schedule it on daily or weekly basis (if you want a daily version as well as a weekly 
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version, create another profile and named it „My weekly OE‟ and schedule the backup on weekly basis in 

case of file corruption). Lastly, make sure you [Save] the settings you have made.  

 

10.6 How do I backup my UBS/MYOB accounting data?  

First of all you will need to find out where the software stores the data on your computer. 

For UBS, you just right click on the application [Properties] 

and pull out the following dialog box. The folder you find at 

[Start in:] is the one that you will want to copy and paste in to 

the [Local Folder] of the StorageSync to backup.  

MYOB  

By default, MYOB saves its data file within the program 

folder ie c:\myob<version>\<filename> .myo or 

\<filename>.dat depending on version for example, 

C:\MYOB15.  

So in the case of the example, you will select C:\MYOB15 as 

your Local Folder and back up everything under this folder to 

a Remote Folder. You will need to create a new folder (i.e. 

MYOB15) under the Remote Folder to contain all the files and 

data you are backing from C:\MYOB15. 

 

 

 

10.7 Can I backup my Oracle/MSQL/MySQL data?  

 

10.8 I have many files of 100GB or more. How long will it take to backup online?  

It depends on the broadband connection that you have subscribed to. While High Speed Broad Band 

might take from 15 hours to 2 days, normal broadband can take up to weeks or months depending on your 

bandwidth.  

However, we do offer a one-time physical data transfer to our Storage Center. That can be done via any 

storage medium (external HDD, USB thumb drive, CD/DVD, etc). Please call to check for the physical 

data transfer service rate. 

 




